
Interactive Physics 
THE WORLDWIDE STANDARD IN PHYSICS SIMULATION SOFTWARE 

BOOST YOUR PHYSICS CURRICULUM WITH POWERFUL 
MOTION SIMULATION TECHNOLOGY 
 
The foundations of scientific discovery are imagination and 
inquisitive “what if” curiosity. Interactive Physics makes your 
students active learners and empowers them to: 
 
• Explore their physical world through fast-paced exciting 

simulation 
• Visualize the abstract scientific concepts taught in the 

classroom 
• Test hypotheses and investigate “what if” scenarios 
• Learn school-to-career job skills with real-world motion tools 
Adopted by more than 18,000 schools worldwide, try Interactive 
Physics and see why it has been named the “Best  Educational 
Software Product” several years running. 

EASY AND FUN TO USE! WATCH PHYSICS IN ACTION! 
 
Create new experiments or interact with pre-designed Physics 
exercises to: 
 
• Measure velocity, acceleration, force, momentum, energy, 

etc., in metric or English units 
• Create ropes, springs, dampers, pulleys, slot joints, linear 

actuators, and rotational motors 
• Hear and measure sound volumes, sound frequencies, 

and Doppler effects 
• Vary air resistance, gravity, or material properties 
• Create visually appealing presentations by attaching 

graphics to objects 
• View results as numbers, graphs, and animated vectors 

Encourage hands-on, minds-on, and can-do attitude in the classroom. 
www.interactivephysics.com 



Help your students make the right moves toward their FUTURE! 
www.interactivephysics.com 

www.interactivephysics.com 

EASY CURRICULUM 
INTEGRATION 
 
Interactive Physics allows 
students to master concepts 
in a safe environment, without 
costly lab supplies and time-
consuming lab setup. Your 
physics lectures and lab ac-
tivities will immediately benefit 
from Interactive Physics! 
 
• Select from a wide range 

of ready-to run exercises 
built for your curriculum 

• Rapidly customize exist-
ing models to meet your 
specific needs 

• Create and share models 
with teachers and stu-
dents 

• Compare simulation data 
with theoretical results 

• Demonstrate hard-to-
explain concepts like 
Coriolis acceleration 

• Show properties of ob-
jects that you cannot see 
in a lab, for example, vec-
tors or the path of a body 

COMPLETE CURRICULUM 
SUPPORT 
 
• Offers both high school 

and college level ancillary 
support, with supplemen-
tary exercises, and activi-
ties for easy lesson plan-
ning and grading 

• Widely adopted by major 
textbooks 

• Complements textbook 
problems 

• Excellent in-class demon-
strations 

• The Interactive Physics 
Homework Edition allows 
students to work at home 
and exchange assign-
ments electronically with 
teachers and other stu-
dents 

 
REAL LIFE APPLICATION 
 
Design Simulation Technolo-
gies  also develops Working 
Model for professional scien-
tists and engineers. Check out 
www.workingmodel.com and 
see the same, professional 
motion simulation technology 
your students learn with Inter-
active Physics! 

CORRELATED WITH NATIONAL EDUCATION  
STANDARDS 
 
Your students master science objectives by creating simula-
tions in essential physics topics, including: 

1-D motion 
2-D motion 
Collisions 
Conservation Laws 
Doppler effects 
Electrostatics 
Equilibrium 
Evaporation 
Frequency 
Friction 
Gears 
Gravitation 
Kinematics 
Kinetic Theory of Gas 
Machines 

Magnetics 
Momentum 
Newton’s Law 
Oscillations 
Particle Dynamics 
Planar Motion 
Projectiles 
Pulley Systems 
Rockets 
Rotational Dynamics 
Sound Intensities 
Statics 
Waves 
Trig Functions 
Work and Energy 

SYSTEM REQUIREMENTS 
 
Windows Systems 
• Microsoft Windows 95/98/ME/2000/XP/Vista/Windows 7 
• 1 GB RAM minimum 
• 60 MB disk space 
• CD-ROM drive 
• Sounds card for sound experi-

ments 

Design Simulation Technologies 
43311 Joy Road, #237 
Canton, MI 48187 
USA 
www.design-simulation.com 
sales@design-simulation.com 
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Welcome to Interactive Physics 
 
Interactive Physics is the result of a 15-year collaborative effort between physics instructors and software engineers. It is correlated with 
National Education Curriculum Standards and it teaches your students the same motion tools used by professional scientists and engineers. 
We are confident that Interactive Physics is a valuable tool for your classroom and laboratory. 
 
To begin, install Interactive Physics and go through each step of the demonstration described below.  
 

Step Related Physics Concepts 
1.  Creating a falling block Mass; freely falling objects; laws of motion; linear kinematics 
2.  Adding a velocity vector Vector and scalar quantities; vector components; unit vector 
3.  Making a pendulum Oscillatory motion; frequency and amplitude; rotational kinematics; centripetal force 
4.  Graphing the pendulum’s motion Graphs and measurements; motion diagrams 
5.  Changing gravity Law of gravity; Newton’s second law 
6.  Adding air resistance Air resistance; non-conservative forces 
7.  Adding a spring Spring oscillation; conservative forces; conservation of energy; kinetic and potential energy 
8.  Controlling the spring constant Spring constant; natural spring length; equilibrium spring length 
9.  Collisions with a circle Collision; elasticity; frictional forces; impulse and momentum 
10.  Attaching a picture to an object Attaching pictures makes physics experiments realistic and fun 
11.  Adding sound Sound waves; speed of sound; Doppler effect; sound frequency and intensity 
12.  Adding a curved slot joint Roller coaster physics; motion in two dimensions; conservation of energy and momentum 
13.  Adding a force Concept of force; Newton’s first law; work and energy 
14.  Running demo files Interactive Physics allows you to explore other essential physics topics, including: 

electrostatics, evaporation and condensation, gears, kinetic theory of gas, machines, 
magnetism, particle dynamics, projectiles and rockets, pulleys, rotational dynamics, static 
equilibrium, superposition of waves, and many more. 

15. Curriculum workbook Correlated with National and State Standards and Objectives, new interactive experiments 
explore speed, distance, time, acceleration, force, weight, mass, gravity, and air resistance 

 

 
Installing Interactive Physics 
 
Windows users: 
1. Insert the Interactive Physics CD into the CD-Rom drive and 
follow the installation instructions 
2. When prompted for a serial number, enter “DEMO” or enter 
your licensed serial number 
3. When the “Choose Folder” window appears, click [OK]. 
4. For a step-by-step introductory tutorial, turn to the next page. 
 

 
 

  
 
 
 
 
 

 
Mac users: 
1. Insert the Interactive Physics CD into the CD-Rom drive. 
Double-click on the InteractivePhysics CD-icon 
2. Double-click on the DoubleClickToInstall icon in the 
interactivePhysics window. Follow the installation instructions 
3. For a step-by-step introductory tutorial, turn to the next page. 
 

  
 
 
 

http://www.interactivephysics.com 
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Starting Interactive Physics 
1. Ensure that Interactive Physics is installed on your computer.  
2. From the Windows  menu, click on Programs and then InteractivePhysics 
and then InteractivePhysics. This opens a new experiment. 
 

1 Creating a Falling Block 
1. The first simulation is Newton’s first experiment, dropping a block.  
2. To draw a rectangle, click on the Rectangle tool, then click in the workspace and 
draw a long thin rectangular block.  
3. To run the experiment and see the block fall due to gravity, click . 
4. Click  to reset the experiment.  
 

 
 
 

2 Adding a Velocity Vector 
1. To add a velocity vector, click on the rectangle. 
2. From the Define menu, click on Vectors and then Velocity. 
3. Click  and observe that the vector changes magnitude as the block falls.  
4. Click .  
 
Optional: To add a numerical value to the velocity vector (or its components), click 
on the Define menu, select Vector Display, and check the Value box. 
 
 

3 Making a Pendulum 
1. To make a pendulum, click on the Pin joint tool and then click on the upper left-
hand corner of the rectangle.  
2. Click  and observe that the vector changes magnitude and direction as the 
pendulum moves.  Click .  
 

 

4 Graphing the Pendulum’s Motion 
1. To graph the pendulum’s motion, click on the rectangle. Under the Measure 
menu, select Position, then select Rotation Graph.  
2. To collect data, click . Note: Data can be displayed as a graph, bar chart, 
or number, and can be changed while running the experiment. Click . 
3. The graph shows the pendulum’s amplitude and frequency. To make the graph 
larger, click on the graph and drag its lower right-hand corner to the right. 
 

 
 
 

5 Changing Gravity 
1. To change gravity, click on the World menu, select Gravity, slide the slider to the 
top for the value 20 m/sec2, and click [OK]. 
2. Click  and observe that, in agreement with theoretical and experimental 
predictions, the pendulum has a higher natural frequency. Click . 
 

 
 
 

6 Adding Air Resistance 
1. Under the World menu, select Air Resistance, click on Low Speed, and accept 
the default air resistance value of 0.3 kg/(m*s) by clicking [OK]. 
2. Click  and observe the exponentially decaying oscillations. Click . 
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7 Adding a Spring 
1. To add a spring, click on the Spring tool. Click on the upper right-hand corner of 
the block and stretch the spring up and to the right. 
2. Click  and observe the pendulum's higher natural frequency and new 
equilibrium position. Click . 
 

 
 
 

8 Controlling the Spring Constant 
1. To control the spring constant, click on the spring. Under the Define menu, select 
New Control, then select Spring Constant.  
2. The slider that controls the spring will appear in the left-hand side of the 
workspace. To move the slider's location closer to the spring, click on its title and 
drag it next to the spring.  
3. To see the effect of varying the spring constant, click  and observe that the 
pendulum angle is a function of the spring-constant (move the slider up and down 
while the experiment is running). Click . 

 
 
 

9 Collisions with a Circle 
1. To create a circle, click on the Circle tool, then click in the workspace and draw a 

circle. (If your rectangle is high on the screen, click  to zoom to extents.) 
2. Click  to start the experiment and observe that the circle bounces and rolls 
on top of the rectangle. Automatic collision and contact is a very useful feature in 
Interactive Physics (even the elastic and frictional properties of objects may be 
varied). Click . 
 

 
 
 

10 Attaching a Picture to an Object 
1. To find the spaceman picture on Windows, select  menu, then Programs, 
then InteractivePhysics, then the IPIntroduction folder. 
 

Note: Mac users browse to Interactive Physics, then Picture Library, then People. 
 

2. Double-click on the bitmap file “Spaceman.bmp.” This should open the bitmap in 
a program such as Paint.   
3. In Paint, select the Edit menu and then choose Select All.  
    Next, select the Edit menu again and then choose Copy.  
4. Go back to Interactive Physics and select its Edit menu and then choose Paste. 
5. To attach the spaceman bitmap to the circle, click on the spaceman, then hold 
down [Shift] while you click on the circle.  
6. Select the Object menu and then Attach Picture. Notice that the circle object has 
disappeared and has been replaced by the spaceman image.  
7. Click  to run the experiment. Click . 
 

Note: Interactive Physics was designed to be easy-to-use. In this exercise, the 
only time you need to touch the keyboard is to hold down the [Shift] key. 
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11 Adding Sound (Windows only) 
1. Click on the spaceman, select the Measure menu and choose Hear the Collision.  
2. Click  to start the experiment and hear the sound when the spaceman 
contacts the block. Click .  
 
 

12 Adding a Curved Slot Joint 
1. To add a Curved Slot Joint, click on the Curved Slot joint tool.  
2. Click on the spaceman and then click on a couple of other places to the right of 
the spaceman, and then double-click to complete the slot (see figure below). 
3. Click  to start the experiment and observe that the spaceman slides down 
the curved slot. Click .  
 

 
 
 

13 Adding a Force 
1. To add thrust to the spaceman to overcome air resistance, click on the Force 
tool, then click on the spaceman, then move the mouse to the left and click again.  
2. Click  to start the experiment and observe that the spaceman overcomes 
air resistance and moves more quickly along the curved slot. Click .  
 

 
 
 

14 Running Demo Files 
Windows users: 

1. Under the Script menu, click on "Run All Demo Files." 
2. Sit back and enjoy a series of demos on a variety of physics topics. 
3. To quit, select the File menu and choose Exit. 

Mac Users: 
1. Browse to the For Demo Users folder installed with Interactive Physics. 
2. Double-click on each of the files, then click Run. 
3. To quit, select the File menu and choose Quit. 

 

 
 
 

15 Curriculum Workbook 
Supplementary workbooks with Interactive Physics exercises of varying difficulty 
are available with purchase. To try the instructional curriculum: 
 
Windows users: Go to the Windows , then Programs, then 
InteractivePhysics, then click on StartCurriculum.html, then choose Demo Users. 
 
Mac users: Open the installation CD and double-click on each of the files in the 
IPCurriculum folder. Follow the on-screen directions. 
 
Note: The Demo Edition can open only Demo files. The Full Edition must be 
purchased to open the curriculum and additional 150+ physics experiments. 
 

  
 

 New interactive experiments explore concepts in Energy, 
Temperature, Heat Transfer, Waves, and Sound 

 Plus experiments in speed, distance, time, acceleration, force, weight, mass, 
gravity, and air resistance 

 New curriculum workbook correlated with National and State Educational 
Standards and Objectives 

 Full-color teacher edition and black-line master student edition 
 
 
 
 
 
 

Last updated 7/15/2005 by Paul Mitiguy and Michael Woo http://www.interactivephysics.com 



Interactive Physics™  
Price # of # of # of # of Price # of # of # of # of

($) CDS Manuals TEW* SCB** ($) CDS Manuals TEW* SCB**

Single User (node-locked)*** IP01NL 249 1 1 1 0 IP01NLUp 119 1 0 1 0
Additional Single User*** IP01 100 1 0 0 0 IP01Up 50 1 0 0 0
10 User IP10 995 1 1 1 1:10 IP10UP 398 1 0 1 1:10
20 User IP20 1,495 1 1 1 1:20 IP20Up 598 1 0 1 1:20
30 User IP30 1,995 1 1 1 1:30 IP30UP 798 1 0 1 1:30
50 User IP50 2,995 1 2 2 1:50 IP50Up 1,198 1 0 2 1:50
75 User IP75 4,245 1 2 2 1:75 IP75Up 1,698 1 0 2 1:75
100 User IP100 5,495 1 3 3 1:100 IP100Up 2,198 1 0 3 1:100
200 User IP200 7,995 1 4 4 1:200 IP200Up 3,198 1 0 4 1:200
300 User IP300 10,495 1 5 5 1:300 IP300UP 4,198 1 0 5 1:300
Custom User IPCustom Call Call Call Call Call IpCustomUp Call Call Call Call Call

IPHW 500 10 0 0 0
IPHWWBK 850 10 0 0 10

IPSCB 195 0 0 0 1:10

IPSCW 495 0 0 0 10
IPSCHW 35 0 0 0 0 By Cindy Schwarz / John Ertel; Calculus-based physics
IPUSR 50 0 1 0 0
IPUSRSP 50 0 1 0 0

Interactive Physics
The Americas Price List – February 1, 2009

http://www.interactivephysics.com

Requires 10+ user license of current Interactive Physics. Allows School to make an 
additional copy of SCB for each home license/CD purchased

Requires 10+ user license of current Interactive Physics.

Description

Workbook9 Homework Bundle

UPGRADE+ from IP5.0, IP2000, 2004++, or higher (Windows)

Item No.

Spanish Manual 

Homework9***

Item No.

http://www.interactivephysics.com

Requires 10+ user license of current Interactve Physics

Requires current Interactive Physics License

Requires current Interactive Physics license
Requires current Interactive Physics license

Student Curriculum Black-line 
Master
Student Curriculum Workbook9

IP Workbook College
Extra Manual

IPACL Call Call Call Call Call
Call 2,500 1 1 0 0

1
2
3

4
5
6
7

8
9

10
11
12

+Interactive Physics upgrades will be accepted with corresponding valid IP5.0 or IP2000 serial number (Windows)

Interactive Physics upgrades ship with installation instructions and an introductory tutorial.  Information about new features is contained in the CD.

p
Training

**SCB = Student Curriculum Black-line Master: one black line master is shipped with the right to reproduce copies for the exact number of licenses purchased

*** Single users and Homework users need to provide a machine ID to obtain a node-locked machine-specific installation serial number (not required for Network Licenses).

Interactive Physics version 5.0 is the current version for the Macintosh and runs under classic mode in Mac OS X, not under native Mac OS X.

q y
Ancillary Curriculum License for special development, training, etc. 

Homework/Student Edition licenses are valid for one year and are limited to 50 bodies, 15 constraints, and 15 output meters.
Textbook Editions are licensed with a Developer version and are able to play simulations created by a developer (for publishers etc.)
Technical support is provided by your software vendor for the first four months of new or upgrade purchases.

International orders: American Express, Visa, MasterCard and bank wire transfers accepted.  For orders shipped to destinations outside of the continental United States 

Sales tax is added unless a Federal Excise Exempt Certificate or Local Sales Use Tax Exempt Certificate is submitted with the purchase order.
When possible, orders are shipped within 48 hours.
All sales are final.  If you are tentative about a purchase, ask for a demonstration copy.
To trade up from  x users  to  y users  (with or without an upgrade), use the following price calculation formula:

Example: 10 user upgrade trade-up to a new 30 user:    ($1995 - $995) +  $398 = $1398
Trade-up price = (new y user price – new x user price)  +   x upgrade price (if applicable)

Multi-user licenses are networkable.

Homework/Student Editions do not include manuals or technical support and are only for student use on student-owned computers (not for school computers).

++ Upgrades to IP2005 from IP2004 are $50 + 50% of the listed upgrade price.

Mac Users: Macintosh customers should try a demo before purchasing to ensure OS compatibility (e.g., Mac OS X Tiger may not install classic mode).

For textbook publishers who bundle with 1000+ Textbook EditionsDeveloper10 

Orders to US and Canada: American Express, Visa, MasterCard, Discover, checks, purchase orders accepted. 

To run Interactive Physics under classic mode on Mac OSX Jaguar or later, it is necessary to log on as an administrator. 

*TEW = Teacher Edition Workbook – part of a full purchase or upgrade product (not sold separately)

Resellers are required to fax the school purchase order when placing an order.

A copy of the school's purchase order and/or purchasing information must accompany all orders from the school ordering the software.

that are less than $1,000 shipping charges will be added to the order or a UPS, DHL, or Fedex account must be provided.

13 Prices and terms are subject to change without notice.


